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activinspire 1.4 delivers:

benefits of the new activinspire 1.4 features:

pen modifier tools

1. feature outline 
The new Pen Modifier Toolbox lets you use the Pen, Highlighter or 
Magic Ink tools to draw shapes that behave like annotations.

Users can change from one type of annotation to another without having to swap tools.  For example, users can write on 
the board, neatly underline the text or draw a border and then continue writing - without the need to swap tools.

Using the eraser, users can erase all or part of an annotation created with the Pen Modifier.

Pen Modifiers will only work, or display in your menus, when using the Pen, Highlighter and Magic Ink Tools.

1.1 Pen Modifier Tools available:

• �Three exciting new features to enhance creating and using flipcharts
• �An update to Self-Paced Learning
• �5 new languages – Thai; Czech; Malaysian Bahasa; Hungarian; Japanese (horizontal text)
• �Improvements to speed and performance
• �Maintenance updates
• �Further ActivClassroom integration  through ActivArena 50 with ActivWand and ActivPanel

• �Working with pages just got even easier and quicker -  create great-looking and engaging pages in an instant
• �Using the Pen just got better – change your styles ‘on the fly’ without swapping tools
• �Add ‘wow’ factor to your flipchart with a host of new effects
• �Create and analyse Excel reports from your Self-Paced Learning assessment data

ActivInspire	
  1.4	
  Release	
  Notes	
  _v1.0	
   Page	
  2	
  
	
  

	
  

Pen	
  Modifier	
  Tools	
  

1	
   Feature	
  Outline	
  
The	
  new	
  Pen	
  Modifiers	
  Toolbox	
  lets	
  you	
  use	
  the	
  Pen,	
  Highlighter	
  or	
  
Magic	
  Ink	
  Tools	
  to	
  draw	
  shapes	
  that	
  behave	
  like	
  annotations.	
  	
  	
  	
  
	
  
Users	
  can	
  change	
  from	
  one	
  type	
  of	
  annotation	
  to	
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1.1 Note:  
Pen	
  Modifiers	
  will	
  only	
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  when	
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  Pen,	
  Highlighter	
  and	
  Magic	
  Ink	
  
Tools.	
  	
  When	
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  such	
  as	
  the	
  ‘Select’	
  tool;	
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1.2	
   Pen	
  Modifier	
  Tools	
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• None	
  (disables	
  modifiers	
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freehand)	
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• Horizontal	
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  Line	
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  Tool	
  
• Rectangle	
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• Ellipse	
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1.3	
   The	
  Pen	
  Modifiers	
  option	
  (View	
  Menu	
  –	
  
see	
  Figure	
  1);	
  will	
  appear	
  as	
  greyed	
  
(faded)	
  out	
  when	
  in	
  a	
  non-­‐
writing/drawing	
  tool	
  mode	
  (tools	
  
excluding	
  pen,	
  highlighter,	
  magic	
  ink).	
  	
  
See	
  example.	
  

	
  
1.4	
  	
   When	
  in	
  Multi-­‐User	
  Mode	
  

(Teacher/Student	
  Pen),	
  the	
  Student	
  will	
  
not	
  be	
  able	
  to	
  select	
  a	
  Pen	
  Modifier,	
  but	
  
can	
  draw	
  with	
  them.	
  	
  Teacher	
  behaviour	
  
remains	
  unaffected.	
  

	
  
	
  

	
  
	
  
	
  
	
  
	
  
1.5	
   As	
  with	
  Pen/Highlighter	
  Tools,	
  users	
  are	
   able	
  to	
  

Figure	
  1	
  

Figure	
  2	
  

• Straight Line
• Horizontal Line
• Vertical Line
• Square Tool
• Rectangle Tool
• Point to Point

• Circle
• Ellipse
• Semi Arc
• Corner Arc
• Arrow
• Callout

Note: The Pen Modifiers feature is available in Professional Edition only.
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pen modifier tools (cont.)

1. feature outline (cont.)

1.2�The Pen Modifiers option (View Menu – see Figure 1); will appear greyed out when in a non-writing/drawing  
tool mode (excluding Pen, Highlighter, Magic Ink).  

1.3 �When in Multi-User Mode (Teacher/Student Pen), the Student will not be able to select a Pen Modifier, but can 
draw with them if the Pen Modifier is already active. 

1.4� �As with Pen/Highlighter Tools, users are able to customise Pen Modifiers – custom colours can be chosen, and widths can be 
altered. See Figure 2.

1.5 The Pen Modifiers feature works with Undo/Redo buttons as normal.

ActivInspire	
  1.4	
  Release	
  Notes	
  _v1.0	
   Page	
  2	
  
	
  

	
  

Pen	
  Modifier	
  Tools	
  

1	
   Feature	
  Outline	
  
The	
  new	
  Pen	
  Modifiers	
  Toolbox	
  lets	
  you	
  use	
  the	
  Pen,	
  Highlighter	
  or	
  
Magic	
  Ink	
  Tools	
  to	
  draw	
  shapes	
  that	
  behave	
  like	
  annotations.	
  	
  	
  	
  
	
  
Users	
  can	
  change	
  from	
  one	
  type	
  of	
  annotation	
  to	
  another	
  without	
  swapping	
  tools.	
  	
  For	
  example,	
  
users	
  can	
  write	
  on	
  the	
  board,	
  neatly	
  underline	
  the	
  text	
  /	
  draw	
  a	
  border,	
  then	
  carry	
  on	
  writing	
  
without	
  swapping	
  tools.	
  
	
  
Users	
  can	
  also	
  erase	
  all	
  or	
  part	
  of	
  an	
  annotation	
  created	
  with	
  Pen	
  Modifiers	
  using	
  the	
  eraser.	
  
	
  
1.1 Note:  
Pen	
  Modifiers	
  will	
  only	
  work/display	
  in	
  your	
  menus	
  when	
  using	
  the	
  Pen,	
  Highlighter	
  and	
  Magic	
  Ink	
  
Tools.	
  	
  When	
  using	
  tools	
  such	
  as	
  the	
  ‘Select’	
  tool;	
  the	
  option	
  will	
  appear	
  as	
  ‘faded/greyed	
  out’	
  
	
  
1.2	
   Pen	
  Modifier	
  Tools	
  available:	
  

• None	
  (disables	
  modifiers	
  and	
  draws	
  
freehand)	
  

• Straight	
  Line	
  
• Horizontal	
  Line	
  
• Vertical	
  Line	
  
• Square	
  Tool	
  
• Rectangle	
  Tool	
  

 

• Circle	
  
• Ellipse	
  
• Semi	
  Arc	
  
• Corner	
  Arc	
  
• Arrow	
  
• Callout	
  
• Point	
  to	
  Point	
  

 
	
  

1.3	
   The	
  Pen	
  Modifiers	
  option	
  (View	
  Menu	
  –	
  
see	
  Figure	
  1);	
  will	
  appear	
  as	
  greyed	
  
(faded)	
  out	
  when	
  in	
  a	
  non-­‐
writing/drawing	
  tool	
  mode	
  (tools	
  
excluding	
  pen,	
  highlighter,	
  magic	
  ink).	
  	
  
See	
  example.	
  

	
  
1.4	
  	
   When	
  in	
  Multi-­‐User	
  Mode	
  

(Teacher/Student	
  Pen),	
  the	
  Student	
  will	
  
not	
  be	
  able	
  to	
  select	
  a	
  Pen	
  Modifier,	
  but	
  
can	
  draw	
  with	
  them.	
  	
  Teacher	
  behaviour	
  
remains	
  unaffected.	
  

	
  
	
  

	
  
	
  
	
  
	
  
	
  
1.5	
   As	
  with	
  Pen/Highlighter	
  Tools,	
  users	
  are	
   able	
  to	
  

Figure	
  1	
  

Figure	
  2	
  

Figure 1

ActivInspire	
  1.4	
  Release	
  Notes	
  _v1.0	
   Page	
  2	
  
	
  

	
  

Pen	
  Modifier	
  Tools	
  

1	
   Feature	
  Outline	
  
The	
  new	
  Pen	
  Modifiers	
  Toolbox	
  lets	
  you	
  use	
  the	
  Pen,	
  Highlighter	
  or	
  
Magic	
  Ink	
  Tools	
  to	
  draw	
  shapes	
  that	
  behave	
  like	
  annotations.	
  	
  	
  	
  
	
  
Users	
  can	
  change	
  from	
  one	
  type	
  of	
  annotation	
  to	
  another	
  without	
  swapping	
  tools.	
  	
  For	
  example,	
  
users	
  can	
  write	
  on	
  the	
  board,	
  neatly	
  underline	
  the	
  text	
  /	
  draw	
  a	
  border,	
  then	
  carry	
  on	
  writing	
  
without	
  swapping	
  tools.	
  
	
  
Users	
  can	
  also	
  erase	
  all	
  or	
  part	
  of	
  an	
  annotation	
  created	
  with	
  Pen	
  Modifiers	
  using	
  the	
  eraser.	
  
	
  
1.1 Note:  
Pen	
  Modifiers	
  will	
  only	
  work/display	
  in	
  your	
  menus	
  when	
  using	
  the	
  Pen,	
  Highlighter	
  and	
  Magic	
  Ink	
  
Tools.	
  	
  When	
  using	
  tools	
  such	
  as	
  the	
  ‘Select’	
  tool;	
  the	
  option	
  will	
  appear	
  as	
  ‘faded/greyed	
  out’	
  
	
  
1.2	
   Pen	
  Modifier	
  Tools	
  available:	
  

• None	
  (disables	
  modifiers	
  and	
  draws	
  
freehand)	
  

• Straight	
  Line	
  
• Horizontal	
  Line	
  
• Vertical	
  Line	
  
• Square	
  Tool	
  
• Rectangle	
  Tool	
  

 

• Circle	
  
• Ellipse	
  
• Semi	
  Arc	
  
• Corner	
  Arc	
  
• Arrow	
  
• Callout	
  
• Point	
  to	
  Point	
  

 
	
  

1.3	
   The	
  Pen	
  Modifiers	
  option	
  (View	
  Menu	
  –	
  
see	
  Figure	
  1);	
  will	
  appear	
  as	
  greyed	
  
(faded)	
  out	
  when	
  in	
  a	
  non-­‐
writing/drawing	
  tool	
  mode	
  (tools	
  
excluding	
  pen,	
  highlighter,	
  magic	
  ink).	
  	
  
See	
  example.	
  

	
  
1.4	
  	
   When	
  in	
  Multi-­‐User	
  Mode	
  

(Teacher/Student	
  Pen),	
  the	
  Student	
  will	
  
not	
  be	
  able	
  to	
  select	
  a	
  Pen	
  Modifier,	
  but	
  
can	
  draw	
  with	
  them.	
  	
  Teacher	
  behaviour	
  
remains	
  unaffected.	
  

	
  
	
  

	
  
	
  
	
  
	
  
	
  
1.5	
   As	
  with	
  Pen/Highlighter	
  Tools,	
  users	
  are	
   able	
  to	
  

Figure	
  1	
  

Figure	
  2	
  

Figure 2



1.4 new features guide

page 3

pen modifier tools (cont.)

2. accessing pen modifiers
2.1 ActivStudio:
Select one of the following writing/drawing tools: 

• �Pen
• �Highlighter 
• �Magic Ink

2.1.1 �From the View menu (see Figure 3), select Pen Modifiers.  The Pen Modifiers 
Toolbox will open and appear as a Toolstrip next to the Main Toolbox (see Figure 4)

2.2 ActivPrimary
2.2.1 �Click Pen Modifiers in the Pen Tray. The Pen Modifiers Toolbox will open and 

appear above the Pen Tray (see Figure 5).

Figure 3 Figure 4

Figure 5
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pen modifier tools (cont.)

3. using pen modifiers
3.1 Select a writing/drawing tool (Pen, Highlighter or Magic Ink).
3.2 Select a Pen Modifier from the toolbox / tray.
3.3 Draw your chosen annotation.  For example, write some text and then underline it.
3.4 Click the Pen Modifier to deselect.

Figure 6
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pen modifier tools (cont.)

4. adding pen modifiers to main toolbox
4.1 ���The Pen Modifiers tool can be added to the Main Toolbox as a permanent fixture. 
4.2 Go to File Menu > Settings and select the Commands Tab (see Figure 7).
4.3 Under the ‘All Commands’ column, scroll down and select Pen Modifiers.
4.4 Click the Add button > Done
4.5 The Pen Modifiers icon will appear in your toolbox.

Figure 7
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page turn effects

1 feature outline
Choose from a range of animations to give the finishing touch to any flipchart.  Effects can be set up to run when you navigate 
from one page to another, invoke a keyboard shortcut, or trigger page navigation through an action or the countdown clock.

1.1. Effects Available:

                  

1.1.2 �Effects can be applied application-wide; where the chosen effect automatically applies to all the pages in the flipchart        
Alternatively, ‘per-page’ effects can be applied; where a different effect can be applied to each page.

2. default settings (figure 1)
By default, transitions are switched off and the default effect  
is ‘None’. To access the Settings, go to:
2.1 �File Menu> Settings > Flipchart – Default transition 

should be set to ‘None’

2.2 Default page turn renderer is set to ‘Software’.

2.3 Default duration is set to ‘15’ (1.5 seconds).

Effects can be applied application-wide; where the chosen effect  
automatically applies to all the pages in the flipchart Alternatively,  
‘per-page’ effects can be applied; where a different effect can be  
applied to each page.

Figure 1

• �Random
• �Page Curl
• �Cross Fade
• �Cube Rotate
• �Flip Over
• �Spin Squares
• �Page Fold
• �Push Right
• �Strip Fall

• �Spin Corner
• �Spin Out
• �Rotate Reveal
• �Promethean Man
• �Curtains
• �Star
• �Shatter
• �Wipe
• �Genie
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  page	
  to	
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  and	
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  Page	
  Buttons,	
  keyboard	
  shortcut,	
  or	
  
when	
  an	
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  /	
  countdown	
  clock	
  triggers	
  a	
  page	
  navigation.	
  
	
  
1.1	
   Effects	
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  (no	
  effect	
  shows)	
  
• Random	
  
• Page	
  Curl	
  
• Cross	
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• Cube	
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• Flip	
  Over	
  
• Spin	
  Squares	
  
• Page	
  Fold	
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  Right	
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• Spin	
  Corner	
  
• Spin	
  Out	
  
• Rotate	
  Reveal	
  
• Promethean	
  Man	
  
• Curtains	
  
• Star	
  
• Shatter	
  
• Wipe	
  
• Genie	
  

	
  

1.1.2	
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  can	
  be	
  applied	
  application-­‐wide;	
  where	
  the	
  chosen	
  effect	
  automatically	
  applies	
  to	
  all	
  
the	
  pages	
  in	
  the	
  flipchart.	
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  ‘per-­‐page’	
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  be	
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  a	
  different	
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  be	
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  to	
  each	
  page.	
  
	
  

2 Default Settings (Figure 1) 
By	
  default,	
  transitions	
  are	
  switched	
  off	
  and	
  the	
  default	
  effect	
  is	
  ‘None’.	
  	
  To	
  check	
  this,	
  go	
  to:	
  
2.1.1 File	
  Menu>	
  Settings	
  >	
  Flipchart	
  –	
  Default	
  transition	
  should	
  be	
  set	
  to	
  ‘None’	
  
2.1.2 Default	
  page	
  turn	
  renderer	
  is	
  set	
  to	
  Hardware	
  
2.1.3 Default	
  duration	
  is	
  set	
  to	
  ‘15’	
  (1.5	
  seconds)	
  

	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  

Figure	
  9	
  

(The Page Turn Effect is available in Professional Edition only)
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page turn effects (cont.)

3. display settings
3.1 The Effects Browsers show different display settings, depending on what mode is being used.
3.2 In Studio mode – you will see a photographic style for each effect setting.
3.3 In Primary mode – you will see a cartoon-like style for each effect setting.  
3.4 Whilst effects take place, the Main Toolbar and Bin will disappear, then reappear once the effect has finished.  
       This  will also occur when using the Tickertape, Vote Screen and Maths Tools.

4. setting application-wide effects
4.1 �Select the View menu > Page Turn Effects. 

The Effects Browser opens (Figure 1).
4.2 �Move the pointer over the thumbnails to preview the effects.
4.3 Click your chosen effect.
4.4 Click ‘Done’.
4.5 �Test page effects by navigating using the ‘Previous’ and ‘Next’            

Page Buttons.
4.6 �Test if effects appear quickly (duration set to ‘5’ (0.5 seconds)) or slowly 

(duration set to ‘30’ (3.0 seconds)).

4.7. alternative page effect trigger buttons
4.7.1 �Press ‘PageUp’ and ‘PageDown’ buttons on keyboard – effects 

should appear after the keys are pressed to the Next / Previous pages 
of the flipchart.

4.7.2  �Clock Function – The effect should appear if the timer has been 
set to count down or up to show the next /previous pages of the 
flipchart.

4.7.3 �Timer – when using LRS devices, set ‘Automatic Page Advance’ and 
apply timer values to prepared questions.  Effects should execute 
when the timer countdown has finished.

 

Figure 1
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3 Note:  
3.1.1	
   Effects	
  Browsers	
  display	
  differently	
  in	
  Studio	
  (photos)	
  /	
  Primary	
  Mode	
  (cartoons)	
  –	
  see	
  

examples	
  shown	
  below	
  
3.1.2 Whilst	
  effects	
  take	
  place,	
  the	
  Main	
  ToolBar	
  and	
  Bin	
  will	
  disappear,	
  then	
  reappear	
  once	
  

effect	
  has	
  finished.	
  	
  The	
  same	
  will	
  occur	
  in	
  similar	
  instances	
  such	
  as	
  when	
  using	
  the	
  
Tickertape,	
  Vote	
  Screen	
  and	
  Maths	
  Tools.	
  
 

4 Setting Application-Wide Effects 

4.1.1	
  	
  	
  	
  	
  Select	
  the	
  View	
  menu	
  >	
  Page	
  
Turn	
  Effects.	
  The	
  Effects	
  
Browser	
  opens	
  (Figure	
  2)	
  

4.1.2	
  	
  	
  	
  	
  	
  Move	
  the	
  pointer	
  over	
  the	
  
thumbnails	
  to	
  preview	
  the	
  
effects	
  

4.1.3 Click	
  your	
  chosen	
  effect	
  
	
  

4.1.4 Click	
  Done	
  
	
  

4.1.5 Test	
  page	
  effects	
  by	
  navigating	
  
using	
  the	
  ‘Previous’	
  and	
  ‘Next’	
  
Page	
  Buttons.	
  
	
  

4.1.6 Test	
  if	
  effects	
  appear	
  quickly	
  
(duration	
  set	
  to	
  ‘5’	
  (0.5	
  
seconds)	
  or	
  slowly	
  (duration	
  
set	
  to	
  ‘30’	
  (3.0	
  seconds))	
  

	
  

	
  
4.2 Alternative	
  Page	
  Effect	
  Trigger	
  Buttons	
  
4.2.1 Press	
  ‘PageUp’	
  and	
  ‘PageDown’	
  buttons	
  on	
  keyboard	
  –	
  effects	
  should	
  appear	
  after	
  the	
  keys	
  

are	
  pressed	
  to	
  the	
  Next	
  /	
  Previous	
  pages	
  of	
  the	
  flipchart.	
  
	
  

4.2.2 Clock	
  Function	
  –	
  The	
  effect	
  should	
  appear	
  if	
  timer	
  has	
  been	
  set	
  to	
  count	
  down	
  or	
  up	
  to	
  show	
  
the	
  next	
  /previous	
  pages	
  of	
  the	
  flipchart.	
  
	
  

4.2.3 Timer	
  –	
  when	
  using	
  LRS	
  devices,	
  set	
  ‘Automatic	
  Page	
  advance’	
  and	
  apply	
  timer	
  values	
  to	
  
prepared	
  questions.	
  	
  Effects	
  should	
  execute	
  when	
  timer	
  countdown	
  has	
  finished.	
  

	
  

4.2.4 Browse	
  to	
  the	
  page	
  to	
  which	
  
you	
  wish	
  to	
  apply	
  the	
  effect	
  
	
  

4.2.5 Go	
  to	
  your	
  Page	
  Browser	
  >	
  

Select	
  the	
  Property	
  tab	
   	
  

	
  >	
  Page	
  Turn	
  Effect	
  >	
  click	
  
on	
  the	
  Browse	
  button	
  	
  
	
  

4.2.6 Select	
  your	
  chosen	
  effect	
  
	
  

4.2.7 Click	
  Done	
  
	
  

4.2.8 Test	
  page	
  effects	
  by	
  
navigating	
  using	
  the	
  ‘Previous’	
  

	
  

Figure	
  10 
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4.2.3 Timer	
  –	
  when	
  using	
  LRS	
  devices,	
  set	
  ‘Automatic	
  Page	
  advance’	
  and	
  apply	
  timer	
  values	
  to	
  

prepared	
  questions.	
  	
  Effects	
  should	
  execute	
  when	
  timer	
  countdown	
  has	
  finished.	
  
	
  
4.3 Setting Individual Page Turn Effects 

	
  
5	
   Extras	
  
5.1	
   Switching	
  off	
  all	
  Effects	
  
5.1.2	
   To	
  switch	
  effects	
  off,	
  follow	
  the	
  instructions	
  above	
  and	
  Select	
  None	
  from	
  the	
  Effects	
  

Browser.	
  
	
  
5.2	
   Saving	
  
5.2.1	
   Effects	
  should	
  still	
  work	
  correctly	
  once	
  a	
  flipchart	
  has	
  been	
  saved	
  and	
  reloaded.	
  	
  	
  

To	
  test:	
  Save	
  a	
  flipchart	
  with	
  each	
  of	
  the	
  effects	
  on	
  a	
  separate	
  page	
  within	
  the	
  same	
  
flipchart.	
  	
  Close,	
  then	
  reload	
  the	
  flipchart	
  and	
  check	
  effects	
  are	
  working	
  on	
  each	
  page.	
  

4.2.4 Browse	
  to	
  the	
  page	
  to	
  which	
  
you	
  wish	
  to	
  apply	
  the	
  effect	
  
	
  

4.2.5 Go	
  to	
  your	
  Page	
  Browser	
  >	
  

Select	
  the	
  Property	
  tab	
   	
  

	
  >	
  Page	
  Turn	
  Effect	
  >	
  click	
  
on	
  the	
  Browse	
  button	
  	
  
	
  

4.2.6 Select	
  your	
  chosen	
  effect	
  
	
  

4.2.7 Click	
  Done	
  
	
  

4.2.8 Test	
  page	
  effects	
  by	
  navigating	
  
using	
  the	
  ‘Previous’	
  and	
  ‘Next’	
  
Page	
  Buttons	
  
	
  

4.2.9 Test	
  if	
  effects	
  appear	
  quickly	
  
(duration	
  set	
  to	
  ‘5’	
  (0.5	
  
seconds)	
  or	
  slowly	
  (duration	
  
set	
  to	
  ‘30’	
  (3.0	
  seconds))	
  

	
  

Figure	
  11 



1.4 new features guide

page 8

page turn effects (cont.)

5 setting individual page turn effects
5.1 Browse to the page to which you wish to apply the effect.
5.2 Go to your Page Browser.  Select the Property tab > Page Turn Effect.  Click on the ‘Browse’ button.
5.3 Select your chosen effect.
5.4 Click ‘Done’.
5.5 Test page effects by navigating using the ‘Previous’ and ‘Next’ page buttons.
5.6 Test if page effects appear quickly (duration set to ‘5’ (0.5 seconds) or slowly (duration set to ‘30’ 
      (3.0 seconds)).

6. page turn effects settings
6.1 Switching off all Effects
6.1.1	 To switch effects off, follow the instructions in Section 4 and select ‘None’ from the Effects Browser.

6.2	 Undo/Redo
6.2.1	 Each effect can be unapplied and reapplied correctly when using undo/redo buttons.  

6.3	 Adding Page Turn Effects to the Main Toolbox
6.3.1	 The Page Turn Effects tool can be added to the Main Toolbox as a permanent fixture (follow 
           instructions below).
6.3.2	 Go to File Menu > Settings and select the ‘Commands’ tab.
6.3.3	 Under ‘All Commands’ column, scroll down and select ‘Page Turn Effects’. See Figure 1.
6.3.4	 Click the ‘Add’ button, then ‘Done’.
6.3.5	 The Page Turn Effects icon will appear in your toolbox.
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4.3 Setting Individual Page Turn Effects 
	
  
5	
   Extras	
  
5.1	
   Switching	
  off	
  all	
  Effects	
  
5.1.2	
   To	
  switch	
  effects	
  off,	
  follow	
  the	
  instructions	
  above	
  and	
  Select	
  None	
  from	
  the	
  Effects	
  

Browser.	
  
	
  
5.2	
   Saving	
  
5.2.1	
   Effects	
  should	
  still	
  work	
  correctly	
  once	
  a	
  flipchart	
  has	
  been	
  saved	
  and	
  reloaded.	
  	
  	
  

To	
  test:	
  Save	
  a	
  flipchart	
  with	
  each	
  of	
  the	
  effects	
  on	
  a	
  separate	
  page	
  within	
  the	
  same	
  
flipchart.	
  	
  Close,	
  then	
  reload	
  the	
  flipchart	
  and	
  check	
  effects	
  are	
  working	
  on	
  each	
  page.	
  

	
  
5.3	
   Undo/Redo	
  
5.3.1	
   Each	
  effect	
  should	
  be	
  unapplied	
  and	
  reapplied	
  correctly	
  when	
  using	
  undo/redo	
  buttons.	
  	
  	
  

To	
  test:	
  Set	
  ‘per	
  page’	
  effects	
  on	
  separate	
  pages,	
  click	
  undo	
  until	
  you	
  reach	
  the	
  beginning	
  of	
  
the	
  sequence,	
  then	
  redo	
  until	
  you	
  reach	
  the	
  end	
  of	
  the	
  sequence.	
  

	
  
5.4	
   Adding	
  Page	
  Turn	
  Effects	
  to	
  the	
  Main	
  Toolbox	
  
5.4.1	
   The	
  Page	
  Turn	
  Effects	
  tool	
  can	
  be	
  added	
  to	
  the	
  Main	
  Toolbox	
  as	
  a	
  

permanent	
  fixture	
  (follow	
  instructions	
  below)	
  
	
  

	
  

	
  
5.4.2 Go	
  to	
  File	
  Menu	
  >	
  Settings	
  and	
  select	
  

the	
  Commands	
  Tab	
  
	
  

5.4.3 Under	
  ‘All	
  Commands’	
  column,	
  scroll	
  
down	
  and	
  select	
  Page	
  Turn	
  Effects	
  
	
  

5.4.4 Click	
  the	
  Add	
  button	
  >	
  Done	
  
	
  

5.4.5 The	
  Page	
  Turn	
  Effects	
  icon	
  will	
  appear	
  
in	
  your	
  toolbox	
  

	
  

6 Factors which Disable Page Turn Effects 
	
  
6.1.1 Page	
  Turn	
  Effects	
  should	
  not	
  appear	
  when	
  navigating	
  between	
  thumbnails	
  through	
  the	
  Page	
  

Browser	
  
6.1.2 Page	
  effects	
  should	
  not	
  appear	
  when	
  navigating	
  between	
  pages	
  whilst	
  in	
  Design	
  Mode	
  
6.1.3 Page	
  effects	
  should	
  not	
  appear	
  when	
  using	
  the	
  Revealer	
  Tool	
  
6.1.4 Page	
  effects	
  should	
  not	
  appear	
  when	
  using	
  the	
  Spotlight	
  Tool	
  
6.1.5 Page	
  effects	
  should	
  not	
  appear	
  when	
  in	
  Desktop	
  Annotation	
  Mode	
  
6.1.6 Page	
  effects	
  should	
  not	
  appear	
  when	
  Page	
  Background	
  is	
  set	
  to	
  Desktop	
  Overlay	
  (Edit	
  

Menu	
  >	
  Page	
  Background)	
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4.3 Setting Individual Page Turn Effects 
	
  
5	
   Extras	
  
5.1	
   Switching	
  off	
  all	
  Effects	
  
5.1.2	
   To	
  switch	
  effects	
  off,	
  follow	
  the	
  instructions	
  above	
  and	
  Select	
  None	
  from	
  the	
  Effects	
  

Browser.	
  
	
  
5.2	
   Saving	
  
5.2.1	
   Effects	
  should	
  still	
  work	
  correctly	
  once	
  a	
  flipchart	
  has	
  been	
  saved	
  and	
  reloaded.	
  	
  	
  

To	
  test:	
  Save	
  a	
  flipchart	
  with	
  each	
  of	
  the	
  effects	
  on	
  a	
  separate	
  page	
  within	
  the	
  same	
  
flipchart.	
  	
  Close,	
  then	
  reload	
  the	
  flipchart	
  and	
  check	
  effects	
  are	
  working	
  on	
  each	
  page.	
  

	
  
5.3	
   Undo/Redo	
  
5.3.1	
   Each	
  effect	
  should	
  be	
  unapplied	
  and	
  reapplied	
  correctly	
  when	
  using	
  undo/redo	
  buttons.	
  	
  	
  

To	
  test:	
  Set	
  ‘per	
  page’	
  effects	
  on	
  separate	
  pages,	
  click	
  undo	
  until	
  you	
  reach	
  the	
  beginning	
  of	
  
the	
  sequence,	
  then	
  redo	
  until	
  you	
  reach	
  the	
  end	
  of	
  the	
  sequence.	
  

	
  
5.4	
   Adding	
  Page	
  Turn	
  Effects	
  to	
  the	
  Main	
  Toolbox	
  
5.4.1	
   The	
  Page	
  Turn	
  Effects	
  tool	
  can	
  be	
  added	
  to	
  the	
  Main	
  Toolbox	
  as	
  a	
  

permanent	
  fixture	
  (follow	
  instructions	
  below)	
  
	
  

	
  

	
  
5.4.2 Go	
  to	
  File	
  Menu	
  >	
  Settings	
  and	
  select	
  

the	
  Commands	
  Tab	
  
	
  

5.4.3 Under	
  ‘All	
  Commands’	
  column,	
  scroll	
  
down	
  and	
  select	
  Page	
  Turn	
  Effects	
  
	
  

5.4.4 Click	
  the	
  Add	
  button	
  >	
  Done	
  
	
  

5.4.5 The	
  Page	
  Turn	
  Effects	
  icon	
  will	
  appear	
  
in	
  your	
  toolbox	
  

	
  

6 Factors which Disable Page Turn Effects 
	
  
6.1.1 Page	
  Turn	
  Effects	
  should	
  not	
  appear	
  when	
  navigating	
  between	
  thumbnails	
  through	
  the	
  Page	
  

Browser	
  
6.1.2 Page	
  effects	
  should	
  not	
  appear	
  when	
  navigating	
  between	
  pages	
  whilst	
  in	
  Design	
  Mode	
  
6.1.3 Page	
  effects	
  should	
  not	
  appear	
  when	
  using	
  the	
  Revealer	
  Tool	
  
6.1.4 Page	
  effects	
  should	
  not	
  appear	
  when	
  using	
  the	
  Spotlight	
  Tool	
  
6.1.5 Page	
  effects	
  should	
  not	
  appear	
  when	
  in	
  Desktop	
  Annotation	
  Mode	
  
6.1.6 Page	
  effects	
  should	
  not	
  appear	
  when	
  Page	
  Background	
  is	
  set	
  to	
  Desktop	
  Overlay	
  (Edit	
  

Menu	
  >	
  Page	
  Background)	
  

Figure	
  12	
  
Figure 1
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page turn effects (cont.)

7 factors which disable page turn effects
7.1 Page Turn Effects will not appear in the following circumstances:
7.1.1 When navigating between thumbnails through the Page Browser
7.1.2 When navigating between pages whilst in Design Mode
7.1.3 When using the Revealer Tool
7.1.4 When using the Spotlight Tool
7.1.5 When in Desktop Annotation Mode
7.1.6 When Page Background is set to Desktop Overlay (Edit Menu > Page Background)

7.2 Situations where other Settings will be affected:
7.2.1 Page Turn Effects can disrupt a page where an automated movie file is playing.  The media will not play until 
         the page turn effect has finished.
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3 Alternative Selection: 
3.1.1 Create	
  5	
  coloured	
  pages	
  within	
  a	
  flipchart	
  
3.1.2	
   Go	
  to	
  your	
  Page	
  Browser,	
  use	
  the	
  SHIFT	
  key;	
  this	
  is	
  where	
  a	
  range	
  of	
  pages	
  can	
  be	
  selected	
  

between	
  the	
  current	
  page	
  (highlighted	
  with	
  a	
  bold	
  black	
  border)	
  and	
  the	
  clicked	
  page	
  
thumbnail	
  of	
  the	
  user’s	
  choice.	
  

 

 
3.1.3	
   The	
  black	
  border	
  will	
  remain	
  on	
  the	
  first	
  selected	
  thumbnail	
  (Figure	
  3);	
  others	
  will	
  appear	
  

with	
  a	
  light	
  blue	
  border.	
  	
  The	
  example	
  below	
  (Figure	
  4)	
  shows	
  the	
  blue,	
  purple,	
  orange	
  and	
  
green	
  thumbnails	
  as	
  being	
  selected.	
  

	
  

Figure	
  14	
  

Figure	
  15	
  

Figure	
  16	
  

multi page select

1 feature outline: studio & primary
Lesson preparation is now even easier with the 
ability to select multiple pages and drag-and-
drop them to another location within the same 
flipchart, or to another one. Users can also cut, 
copy, duplicate, paste or delete multiple pages at 
the same time. Feature will also work with undo/
redo buttons.

2. selecting multiple pages
2.1 �Go to your Page Browser, use the CTRL 

key (Windows/Linux) / Apple Command key 
(Mac) and select multiple page thumbnails 
at random. The first selected page will be 
highlighted with a black border (see Figure  1).

2.2 �When more than one page is selected, page 
thumbnails should be highlighted with a light 
blue border. The black border will then move 
to the final thumbnail selected. The example 
to the right (Figure 2) shows the blue, purple 
and orange thumbnails as being selected.

Figure 1

Figure 2
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3 Alternative Selection: 
3.1.1 Create	
  5	
  coloured	
  pages	
  within	
  a	
  flipchart	
  
3.1.2	
   Go	
  to	
  your	
  Page	
  Browser,	
  use	
  the	
  SHIFT	
  key;	
  this	
  is	
  where	
  a	
  range	
  of	
  pages	
  can	
  be	
  selected	
  

between	
  the	
  current	
  page	
  (highlighted	
  with	
  a	
  bold	
  black	
  border)	
  and	
  the	
  clicked	
  page	
  
thumbnail	
  of	
  the	
  user’s	
  choice.	
  

 

 
3.1.3	
   The	
  black	
  border	
  will	
  remain	
  on	
  the	
  first	
  selected	
  thumbnail	
  (Figure	
  3);	
  others	
  will	
  appear	
  

with	
  a	
  light	
  blue	
  border.	
  	
  The	
  example	
  below	
  (Figure	
  4)	
  shows	
  the	
  blue,	
  purple,	
  orange	
  and	
  
green	
  thumbnails	
  as	
  being	
  selected.	
  

	
  

Figure	
  14	
  

Figure	
  15	
  

Figure	
  16	
  

(The Multi-Page Select feature is available in both Professional Edition and Personal Edition)
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3 Alternative Selection: 
3.1.1 Create	
  5	
  coloured	
  pages	
  within	
  a	
  flipchart	
  
3.1.2	
   Go	
  to	
  your	
  Page	
  Browser,	
  use	
  the	
  SHIFT	
  key;	
  this	
  is	
  where	
  a	
  range	
  of	
  pages	
  can	
  be	
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between	
  the	
  current	
  page	
  (highlighted	
  with	
  a	
  bold	
  black	
  border)	
  and	
  the	
  clicked	
  page	
  
thumbnail	
  of	
  the	
  user’s	
  choice.	
  

 

 
3.1.3	
   The	
  black	
  border	
  will	
  remain	
  on	
  the	
  first	
  selected	
  thumbnail	
  (Figure	
  3);	
  others	
  will	
  appear	
  

with	
  a	
  light	
  blue	
  border.	
  	
  The	
  example	
  below	
  (Figure	
  4)	
  shows	
  the	
  blue,	
  purple,	
  orange	
  and	
  
green	
  thumbnails	
  as	
  being	
  selected.	
  

	
  

Figure	
  14	
  

Figure	
  15	
  

Figure	
  16	
  

multi page select (cont.)

3. alternative selection:
3.1 �Go to your Page Browser, use the SHIFT 

key; this is where a range of pages can be 
selected between the current page (highlighted 
with a bold black border) and the clicked page 
thumbnail of the user’s choice.

3.2 �The black border will remain on the first 
selected thumbnail (Figure 3); others 
will appear with a light blue border.  
The example on right (Figure 3) shows the 
blue, purple, orange and green thumbnails 
as being selected.

4 editing
4.1  �Once page selections have been made, users 

can move, cut, copy, paste, duplicate or delete 
the selected pages. To carry this out, right 
click on one of the thumbnails and menu options will appear (see Figure 4).

4.2 �Shortcut keys can also be used: Cut (CTRL-X), Copy (CTRL-C), 
 Paste (CRTL-V), Duplicate (CTRL-D).

4.3 Alternatively, options can also be selected via the Edit Menu list.

5. extras
5.1 �Users can select pages using keyboard cursor keys

To test: Whilst holding down the CRTL Key/SHIFT key, use the LEFT/RIGHT 
or UP/DOWN cursor keys to select pages.

5.2 �To deselect a single page, press CTRL (Windows/Linux) or Cmd (MAC) and 
click the thumbnail. To deselect all pages click any thumbnail (without any keys  
pressed down).

Figure 3
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4 Editing 
 

4.1.1	
   Once	
  page	
  selections	
  have	
  been	
  
made,	
  users	
  can	
  move,	
  cut,	
  copy,	
  
paste,	
  duplicate	
  or	
  delete	
  the	
  
selected	
  pages.	
  	
  To	
  carry	
  this	
  out,	
  
right	
  click	
  on	
  one	
  of	
  the	
  thumbnails	
  
and	
  menu	
  options	
  will	
  appear	
  (see	
  
Figure	
  5)	
  

	
  
4.1.2	
   Shortcut	
  keys	
  can	
  also	
  be	
  used:	
  Cut	
  

(CTRL-­‐X),	
  Copy	
  (CTRL-­‐C),	
  Paste	
  
(CRTL-­‐V),	
  Duplicate	
  (CTRL-­‐D)	
  

	
  
4.1.3	
   Alternatively,	
  options	
  can	
  also	
  be	
  selected	
  via	
  the	
  Edit	
  Menu	
  list	
  
	
  
	
  
	
  
	
  

	
  
	
  
	
  
	
  
	
  

5 Extras:  
5.1.1 Users	
  can	
  select	
  pages	
  using	
  keyboard	
  cursor	
  keys	
  

To	
  test:	
  Whilst	
  holding	
  down	
  the	
  CRTL	
  Key/SHIFT	
  key,	
  use	
  the	
  LEFT/RIGHT	
  or	
  UP/DOWN	
  
cursor	
  keys	
  to	
  select	
  pages	
  

5.1.2 To	
  deselect	
  a	
  single	
  page,	
  press	
  CTRL	
  (Windows/Linux)	
  or	
  Cmd	
  (MAC)	
  and	
  click	
  the	
  
thumbnail.	
  	
  To	
  deselect	
  all	
  pages	
  click	
  any	
  thumbnail	
  (without	
  any	
  keys	
  pressed	
  down)	
  

Figure	
  17	
  Figure 4
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multi page select (cont.)

6. inserting pages into your flipchart
6.1.2. �Go to Page Browser, right click on the thumbnail of the 

page you wish to insert a blank page before or after.
6.1.2. �From the Insert Menu, select Page > Blank Page After 

Current, or Blank Page Before Current (Figure 5).
Alternatively:
6.1.3	� From your Page Browser’s Popup Menu, select Insert 

Page > Blank Page After Current, or Blank Page Before 
Current (see Figure 6).

7. drag and drop
In addition to the current standard drag and drop (reordering 
one page at a time), multiple selections can be ‘drag-and-drop 
reordered’, and ‘drag-and-copied’ to another flipchart.
7.1.     Moving Single & Multiple Pages
7.1.1. �  �Open two flipcharts, one with 5 coloured pages, and the 

other with a blank new page. 
7.1.2. � �Select the flipchart with coloured pages. Go to Page 

Browser, use the CTRL key (PC) / Apple Command key 
(Mac) and select multiple page thumbnails at random.

7.1.3. � �Drag the selected thumbnails to the second blank flipchart 
(a mini thumbnail will be visible) and release the 

           mouse button.
7.1.4. � All copied (dragged) pages should now be visible .

7.2.     Moving Single & Multiple Pages
7.2.1. Open a flipchart, and create 5-10 coloured/labelled pages.
7.2.2. �Select a range of pages using CTRL/SHIFT functions.
7.2.3. �Drag selected pages within the Page Browser to reorder 

the pages (a mini thumbnail will be visible, see Figure 1).
7.2.4. �Bold black lines will appear when choosing where to place 

within range (see Figure 2).
7.2.5. �Release the mouse button, and pages will appear in a 
           new order.

Figure 6
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7	
   Drag	
  and	
  Drop	
  
In	
  addition	
  to	
  the	
  current	
  standard	
  drag	
  and	
  drop	
  (reordering	
  one	
  page	
  at	
  a	
  time),	
  multiple	
  
selections	
  can	
  be	
  ‘drag-­‐and-­‐drop	
  reordered’,	
  and	
  ‘drag-­‐and-­‐copied’	
  to	
  another	
  flipchart.	
  
	
  
7.1	
   Moving	
  Single	
  &	
  Multiple	
  Pages	
  

	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  

7.1.1	
  	
  	
  	
  	
  	
  Open	
  two	
  flipcharts,	
  one	
  with	
  5	
  coloured	
  
pages,	
  and	
  the	
  other	
  with	
  a	
  blank	
  new	
  
page.	
  	
  	
  

7.1.2	
  	
  	
  	
  	
  	
  Select	
  the	
  flipchart	
  with	
  coloured	
  pages.	
  	
  
Go	
  to	
  Page	
  Browser,	
  use	
  the	
  CTRL	
  key	
  (PC)	
  
/	
  Apple	
  Command	
  key	
  (Mac)	
  and	
  select	
  
multiple	
  page	
  thumbnails	
  at	
  random	
  

7.1.3	
  	
  	
  	
  	
  	
  Drag	
  the	
  selected	
  thumbnails	
  to	
  the	
  
second	
  blank	
  flipchart	
  (a	
  mini	
  thumbnail	
  
will	
  be	
  visible)	
  and	
  release	
  the	
  mouse	
  
button	
  

7.1.4	
  	
  	
  	
  	
  	
  All	
  copied	
  (dragged)	
  pages	
  should	
  now	
  be	
  
visible	
  	
  

	
   	
  
7.3.1	
  	
  	
  	
  	
  Open	
  a	
  flipchart,	
  and	
  create	
  5-­‐10	
  

coloured/labelled	
  pages.	
  
7.3.2	
  	
  	
  	
  	
  	
  Select	
  a	
  range	
  of	
  pages	
  using	
  CTRL/SHIFT	
  

functions	
  
7.3.3 Drag	
  selected	
  pages	
  within	
  the	
  Page	
  

Browser	
  to	
  reorder	
  the	
  pages	
  (a	
  mini	
  
thumbnail	
  will	
  be	
  visible)	
  

7.3.4 Bold	
  black	
  lines	
  will	
  appear	
  when	
  choosing	
  
where	
  to	
  place	
  within	
  range	
  (see	
  example)	
  

7.3.5 Release	
  the	
  mouse	
  button,	
  and	
  pages	
  will	
  
appear	
  in	
  a	
  new	
  order	
  

Figure	
  19	
  

Figure	
  20	
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7.1	
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  &	
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  Pages	
  

	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  

7.1.1	
  	
  	
  	
  	
  	
  Open	
  two	
  flipcharts,	
  one	
  with	
  5	
  coloured	
  
pages,	
  and	
  the	
  other	
  with	
  a	
  blank	
  new	
  
page.	
  	
  	
  

7.1.2	
  	
  	
  	
  	
  	
  Select	
  the	
  flipchart	
  with	
  coloured	
  pages.	
  	
  
Go	
  to	
  Page	
  Browser,	
  use	
  the	
  CTRL	
  key	
  (PC)	
  
/	
  Apple	
  Command	
  key	
  (Mac)	
  and	
  select	
  
multiple	
  page	
  thumbnails	
  at	
  random	
  

7.1.3	
  	
  	
  	
  	
  	
  Drag	
  the	
  selected	
  thumbnails	
  to	
  the	
  
second	
  blank	
  flipchart	
  (a	
  mini	
  thumbnail	
  
will	
  be	
  visible)	
  and	
  release	
  the	
  mouse	
  
button	
  

7.1.4	
  	
  	
  	
  	
  	
  All	
  copied	
  (dragged)	
  pages	
  should	
  now	
  be	
  
visible	
  	
  

	
   	
  
7.3.1	
  	
  	
  	
  	
  Open	
  a	
  flipchart,	
  and	
  create	
  5-­‐10	
  

coloured/labelled	
  pages.	
  
7.3.2	
  	
  	
  	
  	
  	
  Select	
  a	
  range	
  of	
  pages	
  using	
  CTRL/SHIFT	
  

functions	
  
7.3.3 Drag	
  selected	
  pages	
  within	
  the	
  Page	
  

Browser	
  to	
  reorder	
  the	
  pages	
  (a	
  mini	
  
thumbnail	
  will	
  be	
  visible)	
  

7.3.4 Bold	
  black	
  lines	
  will	
  appear	
  when	
  choosing	
  
where	
  to	
  place	
  within	
  range	
  (see	
  example)	
  

7.3.5 Release	
  the	
  mouse	
  button,	
  and	
  pages	
  will	
  
appear	
  in	
  a	
  new	
  order	
  

Figure	
  19	
  

Figure	
  20	
  

Figure 1

Figure 2

Figure 5
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self-paced export to excel

1. feature outline
This is an extension to existing Self-Paced Learning functionality which was originally released in ActivInspire 1.2.  The new 
functionality allows users to export question and response data to Excel (TM)  in .xls format. This format can also be used 
by Open Office.  The Export to Excel feature supports the export of questions and responses from flipcharts where there 
are a combination of Self-Paced Learning assessments and single questions on pages.

2. workbook improvements
In order to clearly present the results of a Self-Paced Learning question set to the user, the workbook has been updated.  
These enhancements are outlined below:
	 • New layout which is easier to read and analyse results at a glance.
	 • Extended support for export to .xls format, including from Self-Paced Learning.
	 • Data is now organised by question and student.
	 • �New ‘questions’ tab includes all questions – one spreadsheet now consolidates what was previously held in 

multiple spreadsheets.
	 • Within the spreadsheet, Self- Paced Learning data is visually differentiated:

•	Grey = questions asked but not answered
•	White = questions not answered

• Results displayed in the browser can be any combination of Self-Paced Learning or regular ActivExpression 
voting results.

3. example
3.1 Create a Self-Paced Question Set in the normal way through selecting File Menu > Insert > Self-Paced Question Set.   
      This is illustrated in Figure 1 below.

Figure 1
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Self-­‐Paced	
  Export	
  to	
  Excel	
  

1. Feature	
  Outline	
  
This	
  is	
  an	
  extension	
  to	
  existing	
  Self-­‐Paced	
  Learning	
  functionality	
  which	
  was	
  originally	
  released	
  
in	
  ActivInspire	
  1.2/1.3.	
  	
  The	
  new	
  functionality	
  allows	
  users	
  to	
  export	
  question	
  and	
  response	
  
data	
  to	
  Excel	
  97	
  in	
  .xls	
  format.	
  This	
  format	
  can	
  also	
  be	
  used	
  by	
  Open	
  Office.	
  	
  The	
  Export	
  to	
  
Excel	
  feature	
  supports	
  the	
  export	
  of	
  questions	
  and	
  responses	
  from	
  flipcharts	
  where	
  there	
  are	
  
a	
  combination	
  of	
  Self-­‐Paced	
  Learning	
  assessments	
  and	
  single	
  questions	
  on	
  pages.	
  

	
  
2. Workbook Improvements 

In	
  order	
  to	
  clearly	
  present	
  the	
  results	
  of	
  a	
  Self-­‐Paced	
  Learning	
  question	
  set	
  to	
  the	
  user,	
  the	
  
workbook	
  has	
  been	
  updated.	
  	
  These	
  enhancements	
  are	
  outlined	
  below:	
  

• New	
  layout	
  which	
  should	
  be	
  easier	
  to	
  read	
  and	
  analyse	
  results	
  at	
  a	
  glance	
  
• Extended	
  support	
  for	
  export	
  to	
  .XLS	
  format,	
  including	
  from	
  Self-­‐Paced	
  Learning	
  
• Data	
  is	
  now	
  organised	
  by	
  question	
  and	
  student	
  
• New	
  ‘questions’	
  tab	
  includes	
  all	
  questions	
  –	
  one	
  spreadsheet	
  now	
  consolidates	
  what	
  was	
  

previously	
  held	
  in	
  multiple	
  spreadsheets	
  
• Within	
  the	
  spreadsheet,	
  Self-­‐	
  Paced	
  Learning	
  data	
  is	
  visually	
  differentiated:	
  

o Grey	
  =	
  questions	
  asked	
  but	
  not	
  answered	
  
o White	
  =	
  questions	
  not	
  answered	
  

• Results	
  displayed	
  in	
  the	
  browser	
  can	
  be	
  any	
  combination	
  of	
  Self-­‐Paced	
  Learning	
  or	
  regular	
  
ActivExpression	
  voting	
  results	
  

	
  

3.  Instructions 
3.1	
  Create	
  a	
  Self-­‐Paced	
  Question	
  Set	
  in	
  the	
  normal	
  way	
  through	
  selecting	
  File	
  Menu	
  >	
  Insert	
  
>	
  Self-­‐Paced	
  Question	
  Set.	
  	
  The	
  screenshot	
  below	
  illustrates	
  this.	
  

	
  

	
  
Figure	
  22	
  Self-­‐Paced	
  menu	
  selection	
  

(Self-Paced Learning is available in Professional Edition only)
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3. example (cont.)

3.2 Run the question session as per normal and once the session is complete, the results will be presented in the 
       Results Browser, which is part of the Voting Browser.

3.3 The results can be displayed in a variety of formats, and can be exported to Excel .xls format for further analysis.  
      Figure 2 below illustrates the ‘Export’ functionality.

3.4 Click on the ‘Export’ button in the Voting Browser.  After selecting the target filename and folder, all of the 
      Question/Assessment/Response instances will be exported to a single Excel .xls spreadsheet with the 
      selected filename.

3.5 Each Excel file will contain 4 worksheets:
1.Summary – Shows every response for every student, total number of questions asked and the percentage correct   
for each student
2. By Question – Shows all responses, grouped and organised by question
3. By Student – Shows all responses, grouped and organised by student
4. Questions – Shows all of the questions/assessments in the flipchart

Figure 2
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3.2	
  Run	
  the	
  question	
  session	
  as	
  per	
  normal	
  and	
  once	
  the	
  session	
  is	
  complete,	
  the	
  results	
  will	
  
be	
  presented	
  in	
  the	
  Results	
  Browser,	
  which	
  is	
  part	
  of	
  the	
  Voting	
  Browser.	
  
3.3	
  The	
  results	
  can	
  be	
  displayed	
  in	
  a	
  variety	
  of	
  formats,	
  and	
  can	
  be	
  exported	
  to	
  Microsoft	
  
Excel	
  97	
  .xls	
  format	
  for	
  further	
  analysis.	
  	
  The	
  screenshot	
  below	
  illustrates	
  the	
  ‘Export’	
  
functionality.	
  

	
  

	
  
Figure	
  23	
  Export	
  to	
  Excel	
  

3.4	
  Click	
  on	
  the	
  ‘Export’	
  button	
  in	
  the	
  Voting	
  Browser.	
  	
  After	
  selecting	
  the	
  target	
  filename	
  
and	
  folder,	
  all	
  of	
  the	
  Question/Assessment/Response	
  instances	
  will	
  be	
  exported	
  to	
  a	
  single	
  
Microsoft	
  Excel	
  (.xls)	
  spreadsheet	
  with	
  the	
  selected	
  filename.	
  

	
  
3.5	
  Each	
  Excel	
  file	
  will	
  contain	
  4	
  worksheets:	
  

1. Summary	
  –	
  Shows	
  every	
  response	
  for	
  every	
  student,	
  total	
  number	
  of	
  questions	
  

asked	
  and	
  the	
  percentage	
  correct	
  for	
  each	
  student	
  
2. By	
  Question	
  –	
  Shows	
  all	
  responses,	
  grouped	
  and	
  organised	
  by	
  question	
  
3. By	
  Student	
  –	
  Shows	
  all	
  responses,	
  grouped	
  and	
  organised	
  by	
  student	
  

4. Questions	
  –	
  Shows	
  all	
  of	
  the	
  questions/assessments	
  in	
  the	
  flipchart	
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self-paced export to excel (cont.)

4. the ‘summary’ worksheet
Figure 3 below illustrates an example of the Summary worksheet.

4.1 The following details are presented in the Summary worksheet:

4.1.1 The Summary worksheet will identify the flipchart from which the responses are exported.  It will show the 
         flipchart file name, location on disk, and the creation date.
4.1.2 The Summary worksheet will show all of the responses for each instance of a question, for every student 
         (label) in the response set.
4.1.3 Students (labels) will be listed in the left hand column, in alphabetical order.
4.1.4 The summary data for each student will include:  the total number of questions 
          asked; the percentage of correct answers, and the total response time.
4.1.5 Instances of Self-Paced Learning questions will have a column header that contains the question number.
         The question number will match the question number on every other worksheet.
4.1.6 Self-Paced Assessment response columns will have a different header so that they can be easily distinguished 
         from non- Self-Paced Assessments.  
4.1.7 Response columns within a single instance of a Self-Paced Assessment will occupy adjacent columns.
4.1.8 The header ‘Self-Paced Assessments’ will show the title of the assessment and the date and time that 
         the assessment was started.
4.1.9	 Self-Paced Assessments will have columns for each question instance in the assessment.  Each question will be 
           represented by enough columns to show all instances, i.e. where students provided more than one response 
           to any single question.
4.1.10	Correct answers will be indicated with a green cell background colour.  Incorrect answers will be indicated 
           with red.  For questions where the correct answer is not known, the cell will have a grey background. 
4.1.11	 Questions that have been asked of a student but no answer given will be indicated with an empty cell 
           with a grey background.
4.1.12	Questions that have not been asked of a particular student will be indicated by an empty cell with a 
           white (or no) background colour.

Figure 3: ‘Summary’ Worksheets
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4.  Worksheets. 
 
4.1	
  The	
  ‘Summary’	
  Worksheet	
  

Below	
  is	
  a	
  screenshot	
  of	
  an	
  example	
  Summary	
  worksheet.	
  

	
  

Figure	
  3:	
  ‘Summary’	
  worksheet	
  

4.2 The	
  following	
  details	
  are	
  presented	
  in	
  the	
  Summary	
  worksheet:	
  
	
  

4.2.1	
  	
  	
   The	
  Summary	
  worksheet	
  will	
  identify	
  the	
  flipchart	
  from	
  which	
  the	
  responses	
  are	
  
exported.	
  	
  It	
  will	
  show	
  the	
  flipchart	
  file	
  name,	
  location	
  on	
  disk,	
  and	
  the	
  creation	
  
date.	
  

	
  
4.2.2 The	
  Summary	
  worksheet	
  will	
  show	
  all	
  of	
  the	
  responses	
  for	
  each	
  instance	
  of	
  a	
  

question,	
  for	
  every	
  student	
  (label)	
  in	
  the	
  response	
  set.	
  
	
  

4.2.3 Students	
  (labels)	
  will	
  be	
  listed	
  in	
  the	
  left	
  hand	
  column,	
  in	
  alphabetical	
  order.	
  
	
  
4.2.4 The	
  summary	
  data	
  for	
  each	
  student	
  will	
  include:	
  	
  the	
  total	
  number	
  of	
  questions	
  

asked;	
  the	
  percentage	
  of	
  correct	
  answers,	
  and	
  the	
  total	
  response	
  time.	
  
	
  
4.2.5 Instances	
  of	
  Self-­‐Paced	
  Learning	
  questions	
  will	
  have	
  a	
  column	
  header	
  that	
  contains	
  

the	
  question	
  number.	
  	
  The	
  question	
  number	
  will	
  match	
  the	
  question	
  number	
  on	
  
every	
  other	
  worksheet.	
  

	
  
4.2.6 Self-­‐Paced	
  Assessment	
  response	
  columns	
  will	
  have	
  a	
  different	
  header	
  so	
  that	
  they	
  

can	
  be	
  easily	
  distinguished	
  from	
  non-­‐	
  Self-­‐Paced	
  Assessments.	
  	
  	
  
	
  
4.2.7 Response	
  columns	
  within	
  a	
  single	
  instance	
  of	
  a	
  Self-­‐Paced	
  Assessment	
  will	
  occupy	
  

adjacent	
  columns.	
  
	
  
4.2.8 The	
  header	
  ‘Self-­‐Paced	
  Assessments’	
  will	
  show	
  the	
  title	
  of	
  the	
  assessment	
  and	
  the	
  

date	
  and	
  time	
  that	
  the	
  assessment	
  was	
  started.	
  
	
  
4.2.9 Self-­‐Paced	
  Assessments	
  will	
  have	
  columns	
  for	
  each	
  question	
  instance	
  in	
  the	
  

assessment.	
  	
  Each	
  question	
  will	
  be	
  represented	
  by	
  enough	
  columns	
  to	
  show	
  all	
  
instances,	
  i.e.	
  where	
  students	
  provided	
  more	
  than	
  one	
  response	
  to	
  any	
  single	
  
question.	
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5. the ‘by question’ worksheet 
Figure 4 below illustrates this.

5.1 The following details are presented in the ‘by question’ worksheet.
5.1.1. 	� The ‘By Question’ worksheet will be used to show the responses from each student grouped and organised by 

each instance of a question.
5.1.2. 	��Each instance of a question will be shown within a group of cells and that group will also show the response from 

each student for that instance.
5.1.3.	�� The group of cells that represents each question instance will be clearly identified by a border around the cells, and 

spacing between each group. 
5.1.4.	 Multiple question instances will be arranged vertically on a worksheet.
5.1.5.	� Each group will show the question number (which will match the question numbering on other worksheets), the question 

itself, the date and time that the question was asked (identifying the instance), and the question summary (type, no of 
options etc...).

Figure 4: ‘By Question’ Worksheet
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4.2.10 Correct	
  answers	
  will	
  be	
  indicated	
  with	
  a	
  green	
  cell	
  background	
  colour.	
  	
  Incorrect	
  
answers	
  will	
  be	
  indicated	
  with	
  red.	
  	
  For	
  questions	
  where	
  the	
  correct	
  answer	
  is	
  not	
  
known,	
  the	
  cell	
  will	
  have	
  a	
  grey	
  background.	
  	
  

	
  
4.2.11 Questions	
  that	
  have	
  been	
  asked	
  of	
  a	
  student	
  but	
  no	
  answer	
  given	
  will	
  be	
  indicated	
  

with	
  an	
  empty	
  cell	
  with	
  a	
  grey	
  background.	
  
	
  
4.2.12 Questions	
  that	
  have	
  not	
  been	
  asked	
  of	
  a	
  particular	
  student	
  will	
  be	
  indicated	
  by	
  an	
  

empty	
  cell	
  with	
  a	
  white	
  (or	
  no)	
  background	
  colour.	
  
	
  

5. The ‘By Question’ Worksheet 
Below	
  is	
  a	
  screenshot	
  of	
  an	
  example	
  the	
  ‘By	
  Question'	
  worksheet.	
  

	
  

Figure	
  24:	
  ‘By	
  Question’	
  worksheet	
  

5.1 The	
  following	
  details	
  are	
  presented	
  in	
  the	
  ‘By	
  Question’	
  worksheet.	
  
	
  

5.1.1	
  	
   The	
  ‘By	
  Question’	
  worksheet	
  will	
  be	
  used	
  to	
  show	
  the	
  responses	
  from	
  each	
  student	
  
grouped	
  and	
  organised	
  by	
  each	
  instance	
  of	
  a	
  question.	
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self-paced export to excel (cont.)

5. the ‘by question’ worksheet  (cont.)

5.1.6 Where a question has multiple instances each instance will be shown within a different group.
         Each instance can be identified by the date and time that the instance occurred.
5.1.7 For each instance, each student response will be shown with the Student Name (label), the student response, 
         and the response time.
5.1.8 Correct answers will be shown with a green background, incorrect answers with a red background.
5.1.9 Responses to questions where the correct answer is not known will be shown with a grey background.
5.1.10 Where a question is asked, but no response given the response and response time cells will be empty 
           with a grey background.
5.1.11 Instances of a Self-Paced Assessment will be shown by grouping all of the questions within the 
          Self-Paced Assessment (e.g. border).  
5.1.12 Instances of a Self-Paced Assessment will also show the Self-Paced Assessment title, Summary text, 
          and the date and time that the assessment was started.
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self-paced export to excel (cont.) Figure 5 below shows an example of the ‘By Student’ Worksheet: 

6. the ‘by student’ worksheet
6.1 �The following details are presented 

in the ‘By Student’ worksheet.
6.1.1 The ‘By Student’ worksheet will 
         show the responses to each  
         question instance, grouped and  
         organised by each student.
6.1.2 The responses for each question 
          instance for each student will be  
          shown within a group of cells.
6.1.3 The group of cells that represents 
         each student will be clearly 
         identified by a border around the 
         cells, and spacing in between 
         each group.  
6.1.4 Multiple groups (students) will be 
         arranged vertically on 
          the worksheet.
6.1.5 The group for each student will 
          show the Student Name and 
          Student ID.
6.1.6 The responses for each student will 
         show the question number, the 
         response and response time.
6.1.7 Correct answers will be shown by 
         showing a green background colour 
         in the response and response 
         time cells.
6.1.8 Incorrect responses will be shown 
          by a red cell background in the 
          response and response time cells.
6.1.9 Where a question does not have 
          a correct answer, the response 
          and response time cells will have a    
          grey background colour.
6.1.10 Questions within a Self-Paced   
           Assessment will be grouped.
6.1.11 An extra column will show the grouping of questions within a Self-Paced Assessment.  The first cell in this 
          column that represents the first question asked in a Self-Paced Assessment will show the Self-Paced Assessment title.
6.1.12 For the first and subsequent rows of response data which are part of a Self-Paced Assessment, this extra column 
           will have a grey background.
6.1.13 Where a response is not part of a Self-Paced Assessment, the cell in this column will have a white background.
6.1.14	Consecutive Self-Paced Assessment within this grouping can be distinguished by the title of the Self-Paced Assessment.
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6. The ‘By Student’ Worksheet 
Below	
  is	
  an	
  example	
  of	
  the	
  ‘By	
  Student’	
  Worksheet:

	
  

Figure	
  5:	
  ‘By	
  Student’	
  worksheet	
  

6.1 The	
  following	
  details	
  are	
  presented	
  in	
  the	
  ‘By	
  Student’	
  worksheet.	
  
	
  

6.1.2 The	
  ‘By	
  Student’	
  worksheet	
  will	
  show	
  the	
  responses	
  to	
  each	
  question	
  instance,	
  
grouped	
  and	
  organised	
  by	
  each	
  student.	
  
	
  

6.1.3 The	
  responses	
  for	
  each	
  question	
  instance	
  for	
  each	
  student	
  will	
  be	
  shown	
  within	
  a	
  
group	
  of	
  cells.	
  

Figure 25
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self-paced export to excel (cont.)

7. the ‘questions’ worksheet
Figure 6 illustrates an example of the ‘Questions’ worksheet:

7.1. The following details are presented in the ‘Questions’ worksheet.
7.1.1. �The ‘Questions’ worksheet will show each question in the flipchart.
7.1.2. Question numbering will match the numbering in the other worksheets.
7.1.3. Questions within a Self-Paced Assessment will be grouped, by a border.
7.1.4. �A group that represents a Self-Paced Assessment will also show the Assessment Title and Description. 
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6.1.4 The	
  group	
  of	
  cells	
  that	
  represents	
  each	
  student	
  will	
  be	
  clearly	
  identified	
  by	
  a	
  border	
  
around	
  the	
  cells,	
  and	
  spacing	
  in	
  between	
  each	
  group.	
  	
  	
  
	
  

6.1.5 Multiple	
  groups	
  (students)	
  will	
  be	
  arranged	
  vertically	
  on	
  the	
  worksheet.	
  
	
  

6.1.6 The	
  group	
  for	
  each	
  student	
  will	
  show	
  the	
  Student	
  Name	
  and	
  Student	
  ID.	
  
	
  

6.1.7 The	
  responses	
  for	
  each	
  student	
  will	
  show	
  the	
  question	
  number,	
  the	
  response	
  and	
  
response	
  time.	
  

	
  
6.1.8 Correct	
  answers	
  will	
  be	
  shown	
  by	
  showing	
  a	
  green	
  background	
  colour	
  in	
  the	
  response	
  

and	
  response	
  time	
  cells.	
  
	
  

6.1.9 Incorrect	
  responses	
  will	
  be	
  shown	
  by	
  a	
  red	
  cell	
  background	
  in	
  the	
  response	
  and	
  
response	
  time	
  cells.	
  

	
  
6.1.10 Where	
  a	
  question	
  does	
  not	
  have	
  a	
  correct	
  answer,	
  the	
  response	
  and	
  response	
  time	
  

cells	
  will	
  have	
  a	
  grey	
  background	
  colour.	
  
	
  

6.1.11 Questions	
  within	
  a	
  Self-­‐Paced	
  Assessment	
  will	
  be	
  grouped.	
  
	
  

6.1.12 An	
  extra	
  column	
  will	
  show	
  the	
  grouping	
  of	
  questions	
  within	
  a	
  Self-­‐Paced	
  Assessment.	
  	
  
The	
  first	
  cell	
  in	
  this	
  column	
  that	
  represents	
  the	
  first	
  question	
  asked	
  in	
  a	
  Self-­‐Paced	
  
Assessment	
  will	
  show	
  the	
  Self-­‐Paced	
  Assessment	
  title.	
  

	
  
6.1.13 For	
  the	
  first	
  and	
  subsequent	
  rows	
  of	
  response	
  data	
  which	
  are	
  part	
  of	
  a	
  Self-­‐Paced	
  

Assessment,	
  this	
  extra	
  column	
  will	
  have	
  a	
  grey	
  background.	
  
	
  

6.1.14 Where	
  a	
  response	
  is	
  not	
  part	
  of	
  a	
  Self-­‐Paced	
  Assessment,	
  the	
  cell	
  in	
  this	
  column	
  will	
  
have	
  a	
  white	
  background.	
  

	
  
6.1.15 Consecutive	
  Self-­‐Paced	
  Assessment	
  within	
  this	
  grouping	
  can	
  be	
  distinguished	
  by	
  the	
  

title	
  of	
  the	
  Self-­‐Paced	
  Assessment.	
  
	
  

7. The ‘Questions’ Worksheet 
Below	
  is	
  a	
  screenshot	
  of	
  the	
  ‘Questions’	
  worksheet:	
  

	
  

7.1 The	
  following	
  details	
  are	
  presented	
  in	
  the	
  ‘Questions’	
  worksheet.	
  
	
  

7.1.1 The	
  ‘Questions’	
  worksheet	
  will	
  show	
  each	
  question	
  in	
  the	
  flipchart.	
  

Figure 6: ‘Questions’ worksheet


